
         

  

 

Câu 1:    I    9  T  n     n t   t n     n  tr n M  roso t wor v  t n t   l  u   n  so n t  o l : 

  A. Ruler(t  n  t  ớ  kẻ)  B. St n  r (t  n  t  u   uẩn) 

  C. T tle(t  n  t  u  ề) D. Menu(thanh menu) 

Câu 2:    I             n      n n  P ste  t  s    n  t    p p  m t t 

  A. Shift + P B. Ctrl + V C. Ctrl + X D. Ctrl + P 

Câu 3: Tron  Wor    1   tron   ộp t o   Font       n n  Supers r pt  ó tá    n    ?  

  A. G      ân B. T o   ỉ số   ớ  C. T o   ỉ số tr n D. G  m  ỡ   ữ 

Câu 4: Với thư điện tử, phát biểu nào sau đây là sai? 

  A. H   n  ờ   ó t    ó       ỉ t     ốn  n  u  v      o  on @y  oo  om 

  B. Một n  ờ   ó t       t     o    n  m n   n  ều lần 

  C. Có t       1 t    ến 1        ỉ k á  n  u 

  D. T p t n   n  kèm t eo t    ó t        v rút  vậy n n  ần k  m tr  v rút tr ớ  k   s    n  

Câu 5:    I    1       n      n n  Copy  t  s    n  t    p p  m t t 

  A. Ctrl + Y B. Ctrl + C C. Ctrl + V D. Ctrl + X 

Câu 6: Thế nào là ngôn ngữ siêu văn bản? 

  A. L  một n ôn n ữ lập tr n   o  ãn  máy t n  IBM v ết r  

  B. L  n ôn n ữ  ùn     o t ếp   ữ   á  máy t n  tron  m n  

  C. L  v n b n t      p v n b n    n   n   âm t  n   v  eo    

  D. L  một n ôn n ữ s  u lập tr n   o M  roso t v ết r  

Câu 7: 02.I.1.04. Câu nào sai tron   á   âu s u:    so n t  o v n b n T ến  V  t tr n máy t n   ần p    

 ó: 

  A. C   n  tr n     tr     T ến  V  t B. P ần mềm    t v rut 

  C. P ần mềm so n t  o v n b n D. Bộ Font   ữ V  t 

Câu 8:    I       P  m t t   n lề   ữ  

  A. Ctrl + R B. Ctrl + J C. Ctrl + I D. Ctrl + L 

Câu 9:    I 6 1   S u k      n   n   muốn t  m 1   n  nữ  ở p    tr n t  s    n : 

  A. C uột p     Insert  Insert Rows Above 

  B. C uột p     Insert  Insert Columns to the Left 

  C. C uột p     Insert  Insert Columns to the Right 

  D. C uột p     Insert  Insert Rows Below 

Câu 10:    I       T    p p  m S o   ép 

  A. Ctrl + Z B. Ctrl + V C. Ctrl + X D. Ctrl + C 

Câu 11:    I           n tr n     tr n    v   á  tr n  t  19  ến  1; t  n ập v o ô P  es tron   ộp t o   

Pr nt l : 

  A. 3-5-19-31 B. 3,5,19-31 C. 3,5,19,31 D. 3-5,19-31 

Câu 12:    I          t ự     n      n n  t  y t ế tron  v n b n t     n: 

  A. View/Replace. . .  B. Home/Find. . .  C. View/Find. . .  D. Home/Replace. . .  

Câu 13: Tron  M  roso t Wor    1        n    n  k     ấy  n  t ự     n n   t ế  

nào? 

  A.  C      p   n  án A v  B  ều  ún   B.  Page LayoutPage SetupPaperPaper size 

  C.  Page LayoutParagraphSize D.  Page LayoutSize 

Câu 14: Kiểu bố trí các máy tính trong mạng gồm: 

  A.   ờn  t ẳn   vòn        á  B.   ờn  t ẳn   vòn   t m   á  

  C.   ờn  t ẳn   s o  t m   á  D.   ờn  t ẳn   vòn   s o 

Câu 15:    I    1  Tron  Wor    1       n    n  v n b n   n  l  t k   á  ký    u  oặ  l  t k    n  số 

t   tự  t  t ự     n n   t ế n o s u k    ã    n v n b n: 

  A. Dùn  l n  Insert → Symbol   



  B. Dùn  l n  Form t→  ont    

  C. Dùn  l n  Home→ C  n Bullets  oặ  Number n  

  D. Dùn  l n  Insert → P  e Bre k… 

Câu 16: Ngôn ngữ đánh dấu siêu văn bản HTML là viết tắt của? 

  A. Hyper Text Memory Line B. Hyper Text Markup Language 

  C. Hyper Transfer Markup Language D. Một  áp án k á  

Câu 17:    I 6 16  Spl t Cell l       n n : 

  A. Gộp n  ều ô t  n  1 

ô 
B. P   n  án k á  C. Xó  b n   ã   o D. C    1 ô t  n  n  ều ô 

Câu 18: 03.I                 ớ  một t    y   m t   s u k      n   m t   ó  t  t ự     n: 

  A. N ấn t    p p  m Ctrl+I B. N áy v o nút l n   tr n t  n   ôn     

  C. N áy v o nút l n   tr n t  n   ôn     D. N ấn t    p p  m Ctrl+B 

Câu 19: 02.I.3.17. Trong Word 2010  t    p p  m Ctrl+R  ó tá    n    ?  

  A. C n  lề   ữ  B. C n  lề p    C. C n  lề trá  D. C n  lề  ều   b n 

Câu 20:    I            n    n  ký tự tron  Wor    1  t     n 

  A. Home v  s    n   á       n n  tron  n óm  l pbo r  

  B. Home v s    n   á       n n  tron  n óm styles 

  C. Home v s    n   á       n n  tron  n óm p r  r p  

  D. Home v s    n   á       n n  tron  n óm  ont 

Câu 21:    I       Tron  Wor    1     t m   m t  “T  n  Lon ” tron   o n v n b n v  t  y t ế t  n  

“ ôn   ô”  t  t ự     n: 

  A. L n  E  t → Go to… B. N ấn t    p p  m Ctrl+H… 

  C. L n  E  t → Se r  … D. N ấn t    p p  m Ctrl+F 

Câu 22: Mạng Internet thuộc loại mạng nào dưới đây? 

  A. M n  m ễn p   B. M n     n rộn  C. M n  k u vự  D. M n  to n  ầu 

Câu 23:    I 6  7         ến ô kế t ếp tron  b n   t  t ự     n: 

  A. Ctrl+Tab B. N ấn T b C. Shift+Tab D. Enter 

Câu 24:    I 1     Font   ữ nằm tron  n óm k   n n  n o  ủ     so n t  o v n b n? 

  A. N ập  l u trữ v n b n B. C    n n  k á  C. Tr n  b y v n b n D. S       v n b n 

Câu 25:    I 6 1   S u k      n  ột  muốn t  m 1  ột nữ  về b n p    t  s    n : 

  A. C uột p     Insert  Insert Columns to the Left 

  B. C uột p     Insert  Insert Columns to the Right 

  C. C uột p     Insert  Insert Rows Below 

  D. C uột p     Insert  Insert Rows Above 

Câu 26: Để tạo một hộp thư điện tử mới: 

  A. N  ờ  s    n  k ôn  t   t o   o m n  một  ộp t   mớ  

  B. N  ờ  s    n  p     ó  t n ất một       ỉ Webs te 

  C. N  ờ  s    n   ó t     n  ký qu   á  n    un   ấp      v  Internet  oặ  t ôn  qu   á        ỉ 

Webs te m ễn p   tr n Internet t   bất kỳ  âu tr n t ế   ớ  

  D. N  ờ  s    n  p     ó sự   o p ép  ủ     qu n qu n lý      v  Internet 

Câu 27:    I    1      n  ậm 1  o n v n b n  s u k      n  o n v n b n  ó t  s    n : 

  A. Ctrl + A B. Ctrl + C C. Ctrl + X D. Ctrl + B 

Câu 28:    I 6 1   Tron  Wor    1       èn   n  v o p    tr n   n    n     n tron  b n   t  t ự  

   n: 

  A. EditRows B. LayoutInsert Above C. TableRows  D. FormatRows  

Câu 29: 02.I.3.16. Tron  Wor    1   t    p p  m Ctrl+L  ó tá    n    ? 



  A. C n  lề  ều   b n B. C n  lề p    C. C n  lề   ữ  
D. C n  lề trá  

Câu 2 

Câu 30: Tron  MS Wor    1      t  y       ớn   n   o t   l  u t     n t ẻ P  e L yout  rồ     n nút     

rồ     n một tùy    n   ớng in 

  A. Page Setup B. Orientation C. Size D. Margins 

Câu 31:    I 1  1  C  n  âu s   tron   á   âu tr  lờ  s u: H  so n t  o v n b n l  p ần mềm  n    n  

  o p ép t ự     n  ôn  v   ? 

  A. N ập v n b n B. S        tr n  b y v n b n 

  C. Lập tr n   D. L u trữ v   n v n b n 

Câu 32: TCP/IP là viết tắt của: 

  A. Transmisson Control Protocol/Internet Protocol 

  B. Transmisson Control Protocol/Intel Penturm 

  C. Technology Central Processing / Intel Pentium 

  D. Technology Central Processing/ Internet Protocol 

Câu 33:    I 6          n   ỉn  nộ   un  tron  một ô  ủ  b n   t     n: 

  A. Home/Cell Alignment.  B. View/Cell Alignment.  

  C. Insert/Cells.  D. C uột p     Cell Alignment.  

Câu 34:    I    8      èn  ấu  á    t  s    n  p  m: 

  A. Backspace B. Space C. Page Up D. Enter 

Câu 35:    I   11  P  m t t   ỉ số   ớ  l : 

  A. Ctrl + = B. Ctrl + Shift + N C. Ctrl + Shift + + D. P   n  án k á  

Câu 36:    I    6       n    n  nền tr n  tron  Wor    1  t     n: 

  A. Page LayoutPage Setup B. Page LayoutPage Paragrap 

  C. Page LayoutParagraphLine and page Break D. Page LayoutPage Background 

Câu 37:    I   18      ủy bỏ t  o tá  v   l m  t  s    n  p  m t t: 

  A. Ctrl + Y B. Ctrl + Z C. Ctrl + B D. Ctrl + A 

Câu 38:    I   11     xuốn   uố  t   l  u t  s    n  t    p p  m n o? 

  A. Enter B. P  e Up  oặ  P  e Down 

  C. Ctrl + End D. Home  oặ  En  

Câu 39:    I 6 11  S u k      n  ột  muốn t  m 1  ột nữ  về b n trá  t  s    n : 

  A. C uột p     Insert  Insert Rows Above 

  B. C uột p  i  Insert  Insert Columns to the Right 

  C. C uột p     Insert  Insert Rows Below 

  D. C uột p     Insert  Insert Columns to the Left 

Câu 40:    I        bật t t   ế  ộSupers r pt(  ỉ số tr n)  t  s    n  t    p p  m t t 

  A. Ctrl + Shift + = B. Ctrl + Shift + P C. Ctrl + Shift + B D. Ctrl + = 

Câu 41:    I   1   Muốn    m  ỡ   ữ 1   n v  t  s    n  p  m t t: 

  A. Ctrl + Shift  B. Ctrl + ] C. Ctrl + [ D. Ctrl +  

Câu 42:    I 6  1  Tron  Wor    1  t ự     n l n  L yout → Delete → Delete Columns tron  b n    : 

  A. C èn  ột B. Xó   ột C. Xóa dòng D. Chèn dòng 

Câu 43: Bộ giao thức truyền thông được dùng phổ biến hiện nay trong mạng toàn cầu Internet là: 

  A. WAN B. Internet C. TCP/IP D. LAN 

Câu 44: Tron  MS Wor    1       n    n  v n b n t eo k  u   n  sá    t  t ự     n:  

  A.  Format - Bullets and Numbering  

  B. T ẻ Home – Paragraph – n ấn v o nút Bullets  oặ  Number n   

  C.  Edit - Bullets and Numbering  

  D.  Tools – Bullets and Numbering  

Câu 45:    I 6  9  Tron  Wor    1        n  ột  t   ặt  on trỏ t   v  tr   ần    n rồ  t ự     n l n  

  A. LayoutSelectTable B. LayoutSelectCell C. LayoutSelectRow D. LayoutSelectColumn 



Câu 46: Chọn một câu đúng: 

  A. K         ó t   p  n  ồ  t  k ẳn    n  n  ờ  n ận      n ận      t   

  B. C ỉ  ó n  ờ      t   mớ   ó quyền truy n ập t p   n  kèm tron  t    ã         

  C. Tron  t      n t   ó   n  kèm t p  n  ờ       ó t   n u      t     n  n   n về một số  ặ     m  ủ  

t p 

  D. Tron   ộp t   (Inbox) k ôn  t    ó t    ủ  n  ờ  k ôn  quen 

Câu 47: Tron  MS Wor    1        ộp  á  ô   n     n  ủ  một b n  t  n  một ô t   t      l n  n o? 

  A. V o t ẻ L yout  n ấp nút Mer e Cells B. V o t ẻ L yout  n ấp nút Spl t T ble 

  C. V o t ẻ L yout  n ập nút M r  n Cells D. V o t ẻ L yout  n ấp nút Spl t Cells 

Câu 48:    I    6    n    n  k  tự  ó t     n    n  : 

  A. C n lề  B. H ớn    ấy  C. Tất    p   n  án tr n D. P ôn    ữ  

Câu 49:    I 1 1               ấu “ ỏ ” tron    ế  ộ    Telex t  p    n ấn p  m   ? 

  A. Phím Z  B. Phím S C. Phím R D. Phím F 

Câu 50: Trang web là gì? 

  A. L  một s  u v n b n       án một       ỉ    t m k ếm 

  B. L  một s  u v n b n       án một tr n    ủ    truy  ập 

  C. L  một s  u v n b n       án p ần mở rộn    ỉ    truy  ập 

  D. L  một s  u v n b n       án một       ỉ    truy  ập 

Câu 51:    I            n    n  k     ấy tron  Wor    1  t     n: 

  A. FormatPage B. ToolsPage Setup 

  C. Page LayoutPage SetupPaper D. EditPage 

Câu 52:    I       Kết t ú  p   n l m v    vớ  Wor   t  t ự     n: 

  A. C  n F le → Ex t 

  B. Ch n Form t → Ex t 

  C. N áy   uột v o b  u t  n  ở  ó  tr n b n trá  m n   n  (t  n  t  u  ề) 

  D. C  n Form t → Close 

Câu 53:    I 6 17  C o b n  s u: 

Stt H  v  t n    m 

1 L  Cẩm Tú 9 

2 L  N ật M n  8 

3 Trần T  n  H  n  8 

Nếu t  bô   en ô L  Cẩm Tú v  bấm p  m Delete t  : 

  A. Ô  ó b  xó  B. C ỉ xó   ữ l  u tron  ô  ô vẫn   ữ n uy n 

  C. Dòn       ô  ó b  xó  D. Cột      ô  ó b  xó  

Câu 54:    I       P át b  u n o s u  ây l  sai k   nó  về s    n  p  m t t    t ự     n t  o tá ? 

  A. Ctrl + V t  n     n  vớ  l n  P ste  B. Ctrl + X t  n     n  vớ  l n  Cut 

  C. Ctrl + A       n to n bộ v n b n  D. Ctrl + N t  n     n  vớ  l n  Open 

Câu 55: Phát biểu nào sau đây là sai về mạng không dây: 

  A. Vùn  p ủ són  k ôn    n   ế 

  B. S    n  són  r   o  b   x   ồn  n o    oặ  v  t n     truyền són  

  C. Dễ   n  mở rộn  

  D. Dễ l p  ặt v   ó t   tr  n k    tr n n  ều       n  k á  n  u 

Câu 56:    s    n  kết nố   ó  ây  máy t n   ần  ó: (   n  áp án    n  xá  n ất) 

  A. Dây m n    á  t  ết b  v o  r  

  B. C n  kết nố   ó  ây (Et ernet)   ây m n  v   á  t  ết b  m n  

  C. M n   n     uột  b n p  m  tr n   uy t web 

  D. Bộ   n  tuyến k ôn   ây     n t o   

Câu 57:    I    1  Tron  Wor    1     t m v  t  y t ế một t  tron  v n b n bằn  một t  k á   t ự  

h  n: 



  A. E  t → F n   n  Repl  e B. E  t → Repl  e 

  C. Home → Replace D. E  t → F n  

Câu 58:    I    7       n    n    m t  “V  t N m” t  n  “Việt Nam”  s u k      n   m t   ó t   ần 

 ùn  t    p p  m n o   ớ   ây? 

  A. Ctrl+U B. Ctrl+B C. Ctrl+E D. Ctrl+I 

Câu 59: Tron  MS Wor    1     t  y     k o n   á     ữ   á  ký tự  t  t ự     n:  

  A.  T ẻ Insert – Font n ấn nút mũ  t n b n   ớ  –    n t ẻ A v n e Sp   n  –    n Exp n e   oặ  

Condensed  

  B.  T ẻ Rev ew – Font n ấn nút mũ  t n b n   ớ  –    n t ẻ A v n e C  r  ter Sp   n  –    n 

Exp n e   oặ  Con ense  

  C. T ẻ Home – Font n ấn nút mũ  t n b n   ớ  –    n t ẻ A v n e C  r  ter Sp   n  –    n 

Exp n e   oặ  Con ense   

  D.  T ẻ P  e L yout – Font n ấn nút mũ  t n b n   ớ  –    n t ẻ A v n e Sp   ng –    n Exp n e  

 oặ  Con ense   

Câu 60:    I 1 1   C  n  âu  ún  tron   á   âu s u 

  A. H  so n t  o v n b n tự  ộn  p ân  á    á  t  tron  một  âu  

  B. Tr n  m n   n  v  tr n  v n b n luôn  ó  ùn  k    t  ớ   

  C. Cá     so n t  o  ều  ó p ần mềm x  lý   ữ V  t  

  D. H  so n t  o v n b n qu n lý v    tự  ộn  xuốn   òn   

Câu 61:    I   18  Tron  Wor    1   t    p p  m Ctrl+E  ó tá    n    ? 

  A. C n  lề   ữ  B. C n  lề  ều   b n C. C n  lề trá  D. C n  lề p    

Câu 62: Tron  MS Wor    1      t  y     k o n   á     ữ       o n v n b n t  t  ết lập t  ? 

  A. Ô L ne Sp   n  tron  t ẻ P  e L yout B. Ô Be ore v  A ter tron  t ẻ P  e L yout 

  C. Ô Above v  Below tron  t ẻ P  e L yout D. Ô Le t v  R   t tron  t ẻ Page Layout 

Câu 63: Chọn câu trả lời sai trong các câu trả lời sau: Kết nối các máy tính thành mạng nhằm mục 

đích: 

  A. N  ều máy t n   ó t    ùn    un   ữ l  u   á  t  ết b   p ần mềm   

  B. S o   ép một l  n  lớn  ữ l  u t  máy n y s n  máy k á  

  C. T o t  n     t ốn  t n  toán lớn 

  D.    v o m n  Inernet n  n    n 

Câu 64:    I        bật t t   ế  ộSubs r pt(  ỉ số   ớ )  t  s    n  t    p p  m t t 

  A. Ctrl + Shift + = B. Ctrl + = C. Ctrl + Shift + B D. Ctrl + Shift + P 

Câu 65: 02.I.1.11.G ữ   á  t        ùn  mấy ký tự trốn     p ân  á  : 

  A. 4 B. 3 C. 1 D. 2 

Câu 66: Phát biểu đúng nhất về bản chất củaInternet: 

  A. L  m n  lớn n ất t ế   ớ  

  B. L  m n   ó   n  tr  u máy   ủ 

  C. L  m n   un   ấp k ố  l  n  t ôn  t n lớn n ất  

  D. L  m n  to n  ầu v  s    n  bộ    o t    truyền t ôn  TCP IP 

Câu 67: Web động là các trang Web: 

  A. Có n  ều tr n  l  n kết  ến tr n    ủ Homep  e 

  B. Một ý k ến k á  

  C. Mở r  k   n n  t  n  tá    ữ  n  ờ   ùn  v  máy   ủ 

  D. Có t    ó n  ều v  eo   n   ộn     

Câu 68:    I 6 1   Tron  Wor    1       èn  ột về p    b n p     ột   n     n tron  b n   t  t ự     n: 

  A. EditColumns B. LayoutInsert Right C. ViewColumns D. FormatColumns 

Câu 69:    I 6        tá   một ô t  n  n  ều ô t  dùng: 

  A. Home  Split cell B. Home  Merge cell 

  C. Layout  Merge cell  D. Layout  Split cell 

Câu 70:    I 1  9 Tr n  b y v n b n l  k   n n    n    n : 



  A. Ký tự (C  r  ter)   o n v n b n (P r  r p ) tr n  v n b n (P  e) 

  B.  o n v n b n (P r  r p ) 

  C. Ký tự (C  r  ter)   o n v n b n (P r  r p ) 

  D. Ký tự (C  r  ter)   òn v n b n (L ne) tr n  v n b n (P  e)  

Câu 71:    I   17  Kết t ú  p   n l m v    vớ  Wor   t  t ự     n: 

  A. Alt + F4 
B. Bấm   uột v o b  u t  n   góc trên bên 

p    m n   n  so n t  o 

  C. Tất     áp án tr n D. File  Exit 

Câu 72:    I   19     k ô  p    t  o tá  v    ủy bỏ  t  s    n  p  m t t: 

  A. Ctrl + B B. Ctrl + A C. Ctrl + Z D. Ctrl + Y 

Câu 73:    I    1     k ở   ộn  p ần mềm MS Wor    1  t  t ự     n: 

  A. N áy   uột v o Do uments 

  B. N áy   uột v o T  s PC 

  C. N áy   uột v o nút St rt → M  roso t O    e→ M  roso t Wor  

  D. N áy   uột v o Downlo  s 

Câu 74:    I            n    n  lề   o  o n v n b n tron  Wor    1  t     n: 

  A. Page LayoutParagraphLine and page Break 

  B. Page LayoutParagraphIndents and Spacing 

  C. Form tP  e… 

  D. ToolsP  e Setup… 

Câu 75: Tron  MS Wor    1       uy n       ữ    ế  ộ      èn v    ế  ộ     è  t  t ự     n: 

  A. V o T ẻ r bbon F le – Word Options – Advance – bỏ    n m   Use Overtype Mo e 

  B. N ấn p  m Insert 

  C. V o T ẻ r bbon F le – Word Options – Advance – bỏ    n m   Use Sm rt  ut  n  p ste 

  D. N ấn p  m C psLo k 

Câu 76:    I    1  K   t      t n 1 v n b n   n  mở  sẽ  ó t n   uốn     x y r ? 

  A. P   n  án k á  B. V n b n k ôn  t       t n v  nó   n       mở 

  C. W n ow tự  ộn  s o   ép v n b n v      t n 

v n b n  ó 
D. Vẫn     t n b n  t  ờn  

Câu 77:    I   17 Tron  Wor   t    p p  m t t    t oát k ỏ  mô  tr ờn  l m v    l : 

  A. Ctrl + Q B. Alt + F5 C. Alt + F4 D. FileExit 

Câu 78:    I   11 T b      á  b  u t  n   ủ   á  l n    n    n    o v n b ntron  wor    1 l : 

  A. Insert B. Home C. Page layout D. View 

Câu 79:    I          mở t p v n b n  ó sẵn t  t ự     n: 

  A. C  n F le→ Open B. C  n F le→ S ve C. C  n F le→ New D. C  n F le→ Close 

Câu 80: Tron  MS Wor    1   l n  Columns nằm tron  t ẻ ______?  

  A.  Insert  B.  Home  C.  Table  D.  Page Layout  

Câu 81:    I 6  1     t o b n   t  t ự     n l n : 

  A. L n  Insert T ble   B. L n  Home T ble   

  C. L n  V ew T ble D. N ấn t    p p  m Ctrl + T   

Câu 82:    I   1   Tron  Wor    1        n n  F leS ve      s    n    ? 

  A. L u 1 t p v n b n  ã  ó v o  ĩ  vớ  t n k á  B. Mở 1 t p v n b n mớ  

  C. Mở 1 t p v n b n  ã  ó D. L u 1 t p v n b n mớ  v o  ĩ  

Câu 83:    I       Tron  Wor    1     xem v n b n tr ớ  k    n t   ùn  l n  n o? 

  A. L n  Form t→P  e Setup B. L n  Form t→ ont 

  C. L n  F le → Pr nt… D. L n  Form t→P  e Number 

Câu 84: Đâu không phải là ưu điểm của dịch vụ thư điện tử: 

  A. C   p   t ấp v  t ờ     n   uy n  ần n   t   t   B. C   p     o v  t ờ     n   ậm 

  C. Một n  ờ   ó t       t    ồn  t ờ    o n  ều D. Có t       t   kèm t p t n 



n  ờ  

Câu 85: Trình bày cú pháp địa chỉ thư điện tử tổng quát? 

  A. <t n   n  n ập>@< 

gmail.com> 
B. <lop9b >@< 

yahoo.com> 

C. <t n truy  ập>@<     

  ỉ máy   ủ  ủ   ộp 

t  > 
D. <t n   n  n ập> 

Câu 86: Chọn câu trả lời sai trong các câu trả lời sau về thành phần của mạng máy tính 

  A. P ần   n    o p ép t ự     n   ữ   á  máy t n  

  B. P ần mềm   o p ép t ự     n   ữ   á  máy t n  

  C. Cá  t  ết b  m n    m b o kết nố   á  máy t n  vớ  n  u 

  D. Các máy tính 

Câu 87: Tron  Wor    1   t    p p  m Ctrl + F1   ó tá    n    ? 

  A. Mở  ộp t o   Font B. Mở  ộp t o   Open 

  C. Mở  ộp t o   S ve D. Mở  ộp t o   P  e Setup 

Câu 88: Web tĩnh là các trang Web: 

  A. Một ý k ến k á  B. K ôn   ó v  eo   y  n   ộn  

  C. Có nộ   un  k ôn  t  y     D. C ỉ  ó một tr n   uy n ất 

Câu 89: Mạng là? 

  A. Một tập   p  á  máy t n       l p  ộ  lập tron   ùn  một p òn  

  B. Một tập   p  á  máy t n       kết nố  t eo một p   n  t    n o  ó 

  C. Một tập   p  á  máy t n       l p  ộ  lập tron   ùn  một tò  n   

  D. Một tập   p  á  máy t n       l p  ộ  lập tron   ùn  một    qu n 

Câu 90: Tron  MS Wor    1     bật t t    n t   t  n  t  ớ  kẻ tr n  ủ  s  so n t  o  t  t ự     n:  

  A.  T ẻ Insert –  án   ấu v o m   Ruler  B.  View – Ruler  

  C.  View – Show/Hide –  án   ấu bỏ  án   ấu v o 

m   Ruler  
D.  View – Outline  

Câu 91: Trong M  roso t Wor    1      k  m tr  n  n  tr ớ  k    n  t ự     n n    

t ế n o? 

  A.  Office ButtonPrintPrint Preview  B.  HomePreview 

  C.  ViewPrint Layout D.  ViewZoom 

Câu 92: P át b  u n o s u  ây sai 

  A. Goo le l  1 tron  n ữn  máy t m k ếm lớn n ất t ế   ớ  

  B. T    ỉ  ó t   v o webs te t ôn  qu  t n m ền webs te  ó 

  C. Một số webs te  ã s    n  IPv6 

  D. Cá  webs te k á  n  u t    ó t n m ền k á  n  u 

Câu 93:    I    9           uy n  on trỏ tr n t   l  u  t  s    n   á  p  m: 

  A. Backspace B. Caps Lock C. Mũ  t n   →  D. Space Bar 

Câu 94:    I 6 1   S u k      n   n   muốn t  m 1   n  nữ  ở p      ớ  t  s    n : 

  A. C uột p     Insert  Insert Columns to the Right 

  B. C uột p     Insert  Insert Rows Below 

  C. C uột p     Insert  Insert Rows Above 

  D. C uột p     Insert  Insert Columns to the Left 

Câu 95:    I 1  6  Tron   á  bộ mã   ớ   ây  bộ mã n o k ôn     tr  T ến  V  t? 

  A. UNICODE B. VNI C. TCVN3 D. ASCII 

Câu 96: Muốn t  y     k    t  ớ     ều rộn   ủ  ô   ột    n  tron  b n  t   t  s    n :  

  A. Layout  Cell Size  Height B. G ữ Ctrl v  kéo  on l n   uột về p    tr ớ  

  C. Layout  Cell Size  Width D. G ữ Ctrl v  kéo  on l n   uột về p    s u 

Câu 97:    I       Cá   ố  t  n     n  tr n m n   n  l m v     ủ  Wor : 

  A. T  n    n    n  B. C  A  B v  C  ều  ún  

  C. T  n  b n     n D. T  n   ôn     



Câu 98:    I    7  Muốn l u v n b n v o  ĩ   t  t ự     n: 

  A. F le → S ve… B. E  t → S ve  C. Insert → S ve… D. E  t → S ve… 

Câu 99: Trong Microsoft Word 201      xó    n  tron  b n   t ự     n n     ế n o? 

  A.  InsertDelete Rows B.  LayoutDeleteDelete Rows 

  C.  TableDelete Rows D.  HomeDelete Rows 

Câu 100: Phát biểu nào sai trong những phát biểu sau: 

  A. M   máy t n  tron  Internet  ều  ó   un        ỉ IP 

  B. Internet l  m n  máy t n  k  n  lồ  kết nố    n  tr  u máy t n   m n  máy t n  tr n k  p t ế   ớ  v  

s    n  bộ    o t    truyền t ôn  TCP IP 

  C. Internet l  m n   ó   n  tr  u máy   ủ 

  D. A   ũn   ó t   l    ủ sở  ữu  ủ  Internet 

Câu 101: 03.I 6  9   Muốn t  m 1  ột b n p     ột  ã   o  s u k      n  ột  ã   o t   ần t  o tá : 

  A. Bô   en  ột  ã   o B. Layout  Insert Right 

  C. Insert Above D. Insert Below 

Câu 102:    I 6  1  Ở   ế  ộ l m v    vớ  b n   muốn t  y     k    t  ớ   ủ  ô tron  b n   t   ần t ự  

   n  á  t  o tá : 

  A. Layout  Cell Size B. Home  Cell Size C. Design  Cell Size D. Insert  Cell Size 

Câu 103:    I   1   Tron  Wor    1   t    p p  m Ctrl+J  ó tá    n    ? 

  A. C n  lề trá  B. C n  lề   ữ  C. C n  lề  ều   b n D. C n  lề p    

Câu 104:    I 1  6         ấu  uyền  s     ỏ   n ã  nặn  t eo k  u Telex t  n   n  vớ  n ữn  p  m 

nào? 

  A. s, f, r, j, x B. f, s, r, x, j C. s, f, x, r, j D. f, s, j, r, x 

Câu 105:    I   1   Tron  Wor    1   t    p p  m Ctrl+U  ó tá    n  gì?  

  A. C uy n s n    ữ  n  o  B. T o   ờn         ân   o v n b n 

  C. T n  k    t  ớ  v n b n D. T t bật   ế  ộ   n    n         ân 

Câu 106:    I       C    n n     n   ủ  M  roso t Wor  l    ? 

  A. T n  toán v  lập b n  B. So n t  o v n b n 

  C. T o  á  t p  ồ     D. C  y  á      n  tr n   n    n  k á  

Câu 107:    I 6     Tron  Wor    1     xó  ô  tr ớ   ết t     n ô  ần xó  rồ  t ự     n: 

  A. Form t → Column B. E  t → Cle r… 

  C. T ble → Obje t… D. L yout → Delete → Delete Cells 

Câu 108: 02.I.2  8     mở một t p mớ  bằn  t    p p  m t t tron  Wor  t   ùn  t    p p  m n o   ớ  

 ây? 

  A. Ctrl + N B. Ctrl + S C. Ctrl + O D. Ctrl + A 

Câu 109:    I      Cá   ôn     tr    úp so n t  o v n b n   ó l : 

  A. T m k ếm v        ú B. T m k ếm v       t     

  C. T m k ếm v  t  y t ế  D. T m k ếm v    ú t     

Câu 110:    I 6 1   Tron  Wor    1        n  òn   t   ặt  on trỏ t   v  tr   ần    n rồ  t ự     n l n  

  A. LayoutSelectRow B. LayoutSelectColumn C. LayoutSelectTable D. LayoutSelectCell 

Câu 111: Tron  MS Wor    1      t  y     k o n   á     ữ   á   òn   t    uy n  ến l m v    vớ   ộp  

t o   ______?  

  A.  Print  B.  Paragraph  C.  Page setup  D.  Font  

Câu 112:    I       Muốn l u v n b n v o  ĩ   t  t ự     n: 

  A. Insert → S ve B. P  e L yout → Save  C. Ctrl + S D. Home  Save 

Câu 113:    I          t ự     n      n n  t m k ếm tron  v n b n t     n: 

  A. View/Replace. . .  B. Home/Find. . .  C. Home/Replace. . .  D. View/Find. . .  

Câu 114:    I          t ự     n      n n  t m k ếm tron  v n b n t     n: 

  A. Ctrl + F B. Ctrl + T C. Ctrl + I D. Ctrl + A 

Câu 115: Tron   á  p át b  u s u  ây p át b  u n o s  : 

  A. M n  k ôn   ây kết nố   á  máy t n  bằn  són  r   o  b   x   ồn  n o     y són  truyền qu  v  



tinh. 

  B. M n  k ôn   ây k ôn    ỉ kết nố   á  máy t n  m   òn   o p ép kết nố  vớ     n t o       ộn   

  C. M n   ó  ây kết nố   á  máy t n  bằn   áp v   á  t  ết b  m n   

  D. M n  k ôn   ây  ần  ó  á  t  ết b  t ự     n v      uy n t ếp  á  t n     u    n    ớn   k uế        

Câu 116: Tron  M  roso t Wor    1        n  òn   ầu t  n  ủ  tất     á   o n lù  về b n p     t ự     n 

n   t ế n o?  

  A.  HomeParagraphIndentationFirst Line B.  HomeParagraphSpacingFirst Line 

  C. HomeParagraphSpecialFirst Line D.  HomeParagraphLine spacingFirst Line 

Câu 117: Đâu không phải là trình duyệt web 

  A. Google chrome B. Mozilla FireFox C. Cố   ố  D. Msn 

Câu 118:    I    1  P  m t t   n lề p    

  A. Ctrl + I B. Ctrl + J C. Ctrl + R D. Ctrl + L 

Câu 119:    I    1     t m k ếm v  t  y t ế một t   oặ  một n óm t  t   ùn : 

  A. Ctrl+H B. Ctrl+G C. Ctrl+K D. Ctrl+F 

Câu 120: Để tham gia vào mạng máy tính cần phải có 

  A. Vỉ m    B. Vỉ m n  C. Bộ k uế       D. Bộ t n    u tập trun  

Câu 121: Tron  M  roso t Wor    1        èn t  m  ột v o p    b n trá  v  tr   on trỏ  

tron  b n   t ự     n n   t ế n o? 

  A.  Table Insert Columns Left B.  LayoutInsert Right 

  C.  TableInsert Columns Right  D.  Layout Insert Left 

Câu 122: Trình duyệt Web là: 

  A. L      n  tr n   uy t v  lo   bỏ  á  Web  ó nộ   un  xấu 

  B. C   n  tr n    úp n  ờ   ùn     o t ếp vớ     t ốn  WWW     truy  ập  ến  á  tr n  Web… 

  C. L  một t   m    ủ       ều   n  W n ows 

  D. L  một     n  tr n     t v rus 

Câu 123:    I 1 1  C    n n  n o k ôn  p    l       n n   ủ  H  so n t  o v n b n: 

  A. D    uy n v n b n  ến t   m   k á  B. N ập v  l u nộ   un  v n b n 

  C.   n    n   o n v n b n D.   n    n  ký tự 

Câu 124:    I       Muốn v ết   ỉ số tr n (v     số   tron  X3) t   t  n ấn t    p p  m  

  A. Ctrl_shift_-  B. Ctrl_Shift_*  C. Ctrl_+ D. Ctrl_Shift_+ 

Câu 125:    I 6 1   Tron  Wor    1       èn   n  v o p      ớ    n    n     n tron  b n   t  t ự  

   n: 

  A. LayoutInsert Below B. TableRows  C. FormatRows  D. EditRows  

Câu 126:    I            n    n  tr n  v n b n tron  Wor    1  t     n: 

  A. FormatPage B. EditPage 

  C. Page LayoutPage Setup D. ToolsPage Setup 

Câu 127:    I 6  8  Tron  Wor    1        n ô  t   ặt  on trỏ t   v  tr   ần    n rồ  t ự     n l n  

  A. LayoutSelectTable B. LayoutSelectRow C. LayoutSelectColumn D. LayoutSelectCell 

Câu 128: E-mail viết tắt của 

  A. Electronic Mail B. Else Mail C. Electrical Mail D. Exchange Mail 

Câu 129:  âu l  n ữn       v  t      n t ? 

  A. Yahoo mail B. Outlook C. Gmail D. OneNote 

Câu 130: Trong MS Wor    1            ột   o  o n v n b n t  t ự     n n   t ế n o?  

  A. T   t ẻ P  e L yout  n ấp    n Columns 

  B. T   t ẻ P  e L yout  n ấp    n L ne Numbers 

  C. T   t ẻ Insert   n ấp    n Columns 

  D. T   t ẻ Home   n ấp    n Columns 

Câu 131: Tron  m n   nternet nộ   un   ó  t n  ồm: 

  A. Dữ l  u   ộ      B. Tất     áp án  ều  ún  



  C.       ỉ n ận        ỉ     
D. T ôn  t n k  m soát l   v   á  t ôn  t n p    v  

khác. 

Câu 132:    I   1  T n mặ    n   ủ    le wor  tự s n  l     

  A. Text Document B. Document Text 

  C. Do ument… - Microsoft word D. Document 

Câu 133:    I    6          on trỏ so n t  o về  uố   òn     n t ờ  tron  Wor  t  n ấn p  m n o s u 

 ây? 

  A. Ctrl + End B. End C. Home D. Page Down 

Câu 134: P át b  u n o s u  ây l  sai 

  A. K ôn  t   s    n  Wor     t o tr n  web 

  B. Tr n    ủ  ủ  1 webs te l  tr n  web      mở r   ầu t  n k   truy  ập webs te  ó 

  C. Tr n Internet  m   s  u v n b n       án 1       ỉ truy  ập t o t  n  1 tr n  web 

  D. Có   lo   tr n  web: tĩn  v   ộng 

Câu 135:    I 1  8 H  so n t  o v n b n l  p ần mềm: 

  A. D  t v rut B. Côn     C. H  t ốn  D.  n    n  

Câu 136:    I 1     Tron   á   á   s p xếp tr n  tự  ôn  v      ớ   ây  tr n  tự n o l    p l  n ất k   

so n t  o một v n b n? 

  A. G  v n b n - trình bày -  n ấn -   ỉn  s   

  B. C ỉn  s   - trình bày -    v n b n -  n ấn 

  C. G  v n b n - s       - trình bày -  n ấn 

  D. G  v n b n - trình bày -   ỉn  s   -  n ấn 

Câu 137: Chủ sở hữu mạng toàn cầu Internet là hãng nào? 

  A. Không có ai l    ủ sở  ữu  ủ  m n  to n  ầu 

Internet 
B. Hãng Intel 

  C. Hãng IBM D. Hãng Microsoft 

Câu 138:    I       P  m t t   n    n   n n    n : 

  A. Ctrl + Z B. Ctrl + I C. Ctrl + N D. Ctrl + P 

Câu 139:    I 6  7  Tron  Wor   t ự     n l n  L yout  Delete → Delete Columns tron  b n    : 

  A. Chèn các dòng B. C èn  á   ột C. Xó   á   ột D. Xóa các dòng  

Câu 140: Giao thức truyền tin siêu văn bản viết tắt là: 

  A. HTTP B. HTML C. WWW D. TCP/IP 

Câu 141:    I    9       n    n    m t  “V  t N m” t  n  “V  t N m”  s u k      n   m t   ó t   ần 

 ùn  t    p p  m n o   ớ   ây? 

  A. Ctrl+E B. Ctrl+U C. Ctrl+I D. Ctrl+B 

Câu 142: Các máy tính trong mạng kết nối vật lý với nhau theo mấy cách: 

  A. 2 B. 1 C. 4 D. 3 

Câu 143:    I    7  Côn  v    n o   ớ   ây không liên qu n  ến v      n    n  tr n   ủ  một v n b n ? 

  A.  ặt k    t  ớ   á  lề  ủ  tr n  ;  B.     k    t  ớ  tr n    ấy 

  C.  ặt   ớn   ủ    ấy D.  ặt k o n   á   t  t  òn   ầu  

Câu 144:    I            n    n    m t  “V  t N m” t  n  “Việt Nam”  s u k      n   m t   ó t   ần 

 ùn  t    p p  m n o   ớ   ây? 

  A. Ctrl+I và Ctrl + U B. Ctrl+I và Ctrl + B C. Ctrl+B D. Ctrl+U và Ctrl + B 

Câu 145: M n  máy t n  không b o  ồm t  n  p ần n o s u  ây? 

  A. Cá  t  ết b  m n  B. Loa 

  C. P ần mềm   úp    o t ếp   ữ  các máy tính D. Các máy tính 

Câu 146:    I 1     M   n o   ớ   ây s p xếp t eo t   tự   n v  x  l  v n b n t  n ỏ  ến lớn? 

  A. K  tự - câu - t  -  o n v n b n B. T  - câu -  o n v n b n - k  tự 

  C. K  tự - t  - câu -  o n v n b n D. T  - k  tự - câu -  o n v n b n 

Câu 147:    I   1  T b      á  l n       ặt tr n   n tron  wor    1 l : 

  A. Page layout B. Insert C. Home D. View 



Câu 148:    I       T    p p  m    mở v n b n mớ  

  A. Ctrl + V B. Ctrl + Z C. Ctrl + N D. Ctrl + X 

Câu 149: Trong Word 2 1        èn t  m  ôn  t    toán     v o v n b n  t  t ự     n  á   n o s u 

 ây? 

  A. View/ Equation B. Home/ Equation 
C. Page Layout / 

Equation 
D. Insert/Equation 

Câu 150:    I            uy n       ữ    ế  ộ   èn v    ế  ộ  è tron  Wor  t  n ấn p  m: 

  A. Enter;  B. Insert;  C. Delete;  D. Shift; 

Câu 151:    I 1     Tron  M  roso t Wor       s   ộp t o   Font   n     n t   l  T me New Rom n     

        T ến  V  t  tron  Un Key  ần xá    n  b n  mã n o   ớ   ây: 

  A. Un  o e  ựn  sẵn B. TCVN3 (ABC) C. Vietware_X D. VNI Windows 

Câu 152:  âu không l        ỉ IP 

  A. 114.150.1.74 B. 8.8.8.8 C. 192.168.1.15 D. 192.168.1.300 

Câu 153:    I   1  Tron  Wor   t    p p  m t t    l u mớ  v n b n l n  ĩ  l : 

  A. Alt + Save B. Ctrl + S C. Ctrl + Shift + S D. Shift + S 

Câu 154: G  o t    truyền t ôn  p   b ến n ất    n n y l    ? 

  A. Telnet B. SMTP C. TCP/IP D. IMAP 

Câu 155:    I          l u t   l  u   n  mở   ớ  một t n k á  t  t ự     n 

  A. K ôn  t   t ự     n      B. C  n F le  Save As  

  C. Nháy nút Ren me tr n t  n   ôn      D. C  n F le  New 

Câu 156:    I    7          on trỏ so n t  o về  ầu  òn     n t ờ  tron  Wor  t  n ấn p  m n o s u 

 ây? 

  A. Home B. End C. Page Down D. Ctrl + End 

Câu 157:    I 1 1  Cá   o n v n b n (P r  r p )      n  n  á   vớ  n  u bở : 

  A. Ký tự trốn  (Sp  e) B. Dòn  (L ne) C. Xuốn   òn  (Enter) D. Trang (Page) 

Câu 158:    I 1 1      ó t             ữ  ó  ấu t ến  V  t vớ  b n  mã UNICODE   ó t      n Font 

n o: 

  A. VNI-Times, VNI-Helve B. Arial, Times New Roman 

  C. C  n Font n o  ũn       D. .VnArial, .VnTime 

Câu 159: Kết nối có dây không cần thiết bị nào trong các thiết bị sau: 

  A. G      m B. Cáp truyền t ôn  C. Vỉ m n  
D. Bộ   n  tuyến k ôn  

dây 

Câu 160: 02.I.2.16.Trong Word  t    p p  m t t    mở t   l  u  ã tồn t   tr n  ĩ  l : 

  A. Shift + O B. Ctrl + O C. Alt + Open D. Ctrl + Shift + O 

Câu 161:    I      T    p p  m t t    mở  ộp t o   F n    Repl  e l : 

  A. Ctrl+F B. Ctrl+B C. Ctrl+H D. Shift+F+R 

Câu 162: Tron  M  roso t Wor     7      n tr n  v n b n ở v  tr   on trỏ   n    n    

t ự     n n   t ế n o? 

  A.  Office ButtonPrintPrintCurrent pageOK B.  Office ButtonPrintAllOK 

  C.  Office ButtonPrintPrintSelectionOK  D.  Office BiittonPrintPrintPageOK 

Câu 163: C  n p át b  u sai 

  A. Tr ờn   uố   ùn  b n p    l  v ết t t  ủ  t n n ớ    y t       

  B. DSN sẽ   uy n           ỉ IP s n    n  k  tự (t n m ền) 

  C. C ỉ  ó t   truy  ập tr n  web t ôn  qu  t n m ền 

  D. M   t n m ền  ồm n  ều tr ờn  p ân  á   n  u bở   ấu   ấm 

Câu 164: Tron  MS Wor    1      t  y     k o n   á     ữ   á  ký tự  t    uy n  ến l m v    vớ   ộp  

t o   ______?  

  A.  Font  B.  Page setup C.  Paragraph  D.  Print  

Câu 165:    I    9  Tron  Wor   k   n ấn  ồn  t ờ   á  p  m Ctrl v  En  sẽ t ự     n v    n o tron  

n ữn  v    s u? 



  A.      on trỏ v n b n  ến  uố  t     n t   

  B.      on trỏ v n b n  ến  uố  v n b n 

  C.      on trỏ v n b n  ến  uố   òn     n t   

  D.      on trỏ v n b n  ến  uố   o n    n t   

Câu 166:  âu không l  tr n   uy t web 

  A. Firefox B. Google Chorme C. Yahoo D. Microsoft Edge 

Câu 167:    I          xó  ký tự   n  kề tr ớ   on trỏ v n b n  t  s    n  p  m: 

  A. Delete B. Backspace C. Shift + D D. Redo 

Câu 168:    I   1   Tron  Wor    1        n n  F leS ve As      s    n    ? 

  A. L u 1 t p v n b n mớ  v o  ĩ  B. Mở 1 t p v n b n mớ  

  C. L u t p v n b n  ã  ó v o  ĩ  vớ  t n k á  D. Mở 1 t p v n b n  ã  ó 

Câu 169: Tron   á  p át b  u nó  về p   n  t  n truyền t ôn  s u  ây p át b  u n o sai 

  A. Cá  máy t n  tron  m n  l  n kết vật l  t eo      á  : kết nố   ó  ây v  kết nố  k ôn   ây  

  B. Tron  m n  k ôn   ây  á  máy t n       kết nố  qu     m truy  ập k ôn   ây  oặ  bộ   n  tuyến 

không dây. 

  C. Tố   ộ truyền  ữ l  u  ủ  m n   ó  ây t  ờn  n  n    n m n  k ôn   ây  

  D. M n  k ôn   ây  ễ mở rộn    n m n   ó  ây 

Câu 170:    I 6 1   Mer e Cell l       n n : 

  A. C    1 ô t  n  n  ều 

ô 
B. Xó  b n   ã   o C. Gộp n  ều ô t  n  1 ô D. P   n  án k á  

Câu 171:    I    8          on trỏ so n t  o về  ầu v n b n t  n ấn p  m n o s u  ây? 

  A. Ctrl + Home B. End C. Page Down D. Ctrl + End 

Câu 172:    I 6     C o   b n  s u   

B n  1  

 

  

B n     

  

Muốn t  b n  1 t  n  b n     s u k   v o      n n  Sp l t Cell t  lự     n số   n  v   ột l : 

  A. Columns 2 và Rows 1 B. Columns 2 và Rows 2 

  C. Columns 1 và Rows 2 D. Columns 1 và Rows 1 

Câu 173:    I 6     K    on trỏ v n b n   n  nằm b n tron  b n  t    á    n    n       áp   n    o 

p ần n o  ủ  b n ? 

  A. Cột  on trỏ v n b n   n  nằm B. Dòn   on trỏ v n b n   n  nằm 

  C. C  b n  D. Ô  on trỏ v n b n   n  nằm 

Câu 174:    I 1  7  Tron   á  p ôn    ữ   ớ   ây  p ôn    ữ n o  ùn  mã Un  o e? 

  A. VNI-Times B. Arial C. VnTime D. VnArial 

Câu 175:    I          mở một t p v n b n mớ  t   ùn  l nh? 

  A. Insert → Open B. Insert → New C. F le → New D. F le → Open 

Câu 176: Câu 11   Tron  M  roso t Wor    1      nén   ữ sát v o n  u  t ự     n n   t ế  

nào? 

  A.  HomeFontCharacter SpacingSpacingExpanded 

  B.  HomeFontCharacter SpacingSpacingNormal 

  C.  Page LayoutPage SetupSize 

  D.  HomeFontCharacter SpacingSpacingCondensed 

Câu 177:    I    1     xó  ký tự v n b n   n  kề s u  on trỏ v n b n  t  s    n  p  m: 

  A. Backspace B. Delete C. Undo D. Ctrl + D 

Câu 178: Địa chỉ thư điện tử được phân cách bởi kí hiệu: 

  A. $ B. & C. # D. @ 

Câu 179:    I            n    n  k  tự t   ùn  l n : 



  A. Insert  symbol B. Home  font 

  C. Page layout  Page setup D. Homet  paragraph 

Câu 180:    I    1 Côn  v    n o s u  ây l  n qu n  ến   n    n  tr n  v n b n: 

  A. T  y     k o n   á    á   òn  B. T  y     k o n   á     ữ   á   o n 

  C. T  y     Font   ữ D.  ặt   ớn    ấy 

Câu 181:    I 6  6       èn v o ô    n    ột  tr ớ   ết t   ần    n ô    n    ột  ần   èn rồ  t ự     n: 

  A. C uột p    → Insert… B. Home → Delete… 

  C. Insert → Cle r… D. Home → Obje t… 

Câu 182: Website là gì? 

  A. Gồm một  oặ  n  ều tr n  web tron     t ốn  HTTP      t         ớ  một       ỉ    truy  ập 

  B. Gồm một  oặ  n  ều tr n  web tron     t ốn  HTML      t         ớ  n  ều       ỉ    truy  ập 

  C. Gồm một  oặ  n  ều tr n  web tron     t ốn  WWW      t         ớ  một       ỉ    truy  ập 

  D. Gồm một  oặ  n  ều tr n  web tron     t ốn  TCP IP      t         ớ  một       ỉ    truy  ập 

Câu 183:    I 1 1   Cá   bố tr   ấu  âu n o s u  ây l   ún : 

  A. An nó :  Ô   Trờ  m     B. An nó  :  Ô  Trờ  m     

  C. An nó :  Ô   Trờ  m       D. An nó :   Ô    Trờ  m      

Câu 184:    I    6  T uộ  t n    n    n  ký tự n o s u  ây k ôn   ún : 

  A. K  u   ữ (Type) B. P ôn  (Font)   ữ 

  C. Cỡ   ữ v  m u s   D.   n    n  lề  o n v n b n 

Câu 185:    I   1      xó  k  tự b n p     on trỏ k   so n t  o v n b n t  s    n  p  m: 

  A. Shift 
B. Back Space 

Câu 29 
C. Delete D. End 

Câu 186: 02.I.2.12.Tab      á  b  u t  n   ủ   á  l n    èn tron  wor    1 l : 

  A. Page layout B. Insert C. Home D. View 

Câu 187: Internet được thiết lập vào năm nào? 

  A. 1983 B. 1999 C. 1989 D. 1890 

Câu 188:    I 6        xó     ô    n    ột  tr ớ   ết t   ần    n ô    n    ột  ần xó  rồ  t ự     n: 

  A. E  t → Cle r… B. Form t →  olumn C. Home → Delete… D. L yout → Delete… 

Câu 189:    I            èn k  tự  ặ  b  t tron  wor   t  s    n : 

  A. Insert  symbol B. Home  font 

  C. Homet  paragraph D. Page layout  Page setup 

Câu 190: Khi thiết kết một mạng máy tính không cần quan tâm đếnyếu tố nào sau đây 

  A.        m l p  ặt m n  v  k   n n  t      n  B. Tố   ộ truyền t ôn  tron  m n  

  C. Số l  t n  ờ  s    n  D. Số l  n  máy t n  t  m     m n  

Câu 191: 03.I   18  Cá  l n    n    n  v n b n           t  n   á  lo   s u: 

  A.   n    n  k  tự B.   n    n   o n v n b n 

  C.   n    n  tr n  D. Tất     á  p   n  án  ều  ún  

Câu 192:    I   1   Muốn t n   ỡ   ữ 1   n v  t  s    n  p  m t t: 

  A. Ctrl + [ B. Ctrl +  C. Ctrl + ] D. Ctrl + Shift  

Câu 193:    I    8     t  y      ỡ   ữ  ủ  một n óm k  tự  ã    n  T  t ự     n l n  Home → Font … 

v     n  ỡ   ữ tron  ô: 

  A. Size B. Font Style C. Font D. Small caps 

Câu 194: Internet là: 

  A. P   n b n nân   ấp  ủ  m n      bộ 

  B. M n  máy t n  kết nố   á  máy t n  tr n k  p t ế   ớ   s    n     o t    TCP IP 

  C. Do Microsoft phát hành 

  D. V    kết nố   á  máy t n  tron  m n      bộ t ôn  qu  1 máy   ủ 

Câu 195:    I 6 16  Tron  Wor    1     t o b n  bằn  bút vẽ  t  t ự     n: 

  A. Insert → T ble → Dr w T ble  B. Tools → Insert → T ble 



  C. Insert → T ble D. Insert → Insert → T ble 

Câu 196: Trong số các địa chỉ dưới đây, địa chỉ nào là địa chỉ thư điện tử? 

  A. www.quantrimang.net B. huulung@gmail.com 

  C. http://www.mail.google.com D. http://www.google.com.vn 

Câu 197:    I   19  C  n  âu s   tron  n ữn   âu s u: Tron  Wor    1    ộp t o   P  e Setup   o p ép 

n  ờ   ùn ? 

  A. T  y     Font   ữ B. T  ết lập  ỡ tr n    ấy 

  C. T  y       ớn    ấy D. T  y     lề v n b n 

Câu 198: Câu trả lời nào sai trong các câu trả lời sau: Thông tin nào sau đây liên quan tới 

Internet? 

  A. Cun   ấp một l  n  t ôn  t n k  n  lồ B. S    n  bộ    o t    TCP IP 

  C. L  m n     n rộn  D. M n  máy t n  lớn n ất to n  ầu 

Câu 199: 02.I       L n    n    n  v n b n n o s u  ây k ôn   ún : 

  A.   n    n  k  tự B.   n    n  tr n  v n b n 

  C.   n    n   o n v n b n D.   n    n  tr n  m n   n  

Câu 200: Mạng máy tính bao gồm mấy thành phần 

  A. 3 B. 2 C. 4 D. 5 

Câu 201: 03.I.1.11. Trong  á  p át b  u s u  p át b  u n o  ún  

  A. C  tr ớ  v  s u  ấu   ấm  ều  ó 1  ấu  á   

  B. S u  ấu   ấm n  t  âu  ó 1  ấu  á   (nếu s u  ó vẫn  òn nộ   un ) 

  C. M   lần  ùn   ấu   ấm  ều p    s    n  p  m Enter    xuốn   òn    

  D. Tr ớ   ấu   ấm n  t  âu p     ó 1  ấu  á   

Câu 202: P  m t t   n lề trá   

  A. Ctrl + J B. Ctrl + R C. Ctrl + L D. Ctrl + I 

Câu 203:    I 6 1   Tron  Wor    1       èn  ột về p    b n trá   ột   n     n tron  b n   t  t ự  

   n: 

  A. EditColumns B. LayoutInsert Left C. FormatColumns D. ViewColumns 

Câu 204: Tron  M  roso t Wor    1   s    n  p  m n o    tá   một  o n v n b n  

t  n  n  ều  o n v n b n? 

  A.  Enter B.  Home C.  Tab D.  Delete 

Câu 205:    I 1        kết t ú   o n v       on trỏ v n b n xuốn   ầu  òn  mớ   t  s    n  p  m: 

  A. Alt + Enter B. Enter C. Shift + Enter D. Ctrl + Enter 

Câu 206:    I   1      về  ầu t   l  u t  s    n  t    p p  m n o? 

  A. Ctrl + Home B. P  e Up  oặ  P  e Down 

  C. Home  oặ  En  D. Enter 

Câu 207: 02.I.6     Tron  Wor    1  t ự     n l n  L yout → Delete → Delete Rows tron  b n    : 

  A. Chèn dòng B. C èn  ột C. Xó   ột D. Xóa dòng 

Câu 208:    I       P  m t t   n    n         ân: 

  A. Ctrl + U B. Ctrl + N C. Ctrl + G D. Ctrl + Z 

Câu 209: IP là gì? 

  A. L  số l  n  p ép t n  m  máy t n   ó t   t n  toán      tron  1   ây 

  B. L        ỉ  uy n ất m  m   máy t n  t  m     v o m n   ều  ó 

  C. L  n   máy t n  t ự     n v    truyền  ữ l  u 

  D. L  bộ quy t   m  máy t n   ần tuân t ủ k   t  m     v o m n  

Câu 210:    I       C  n  âu s   tron   á   âu tr  lờ  s u: Tron  Wor    1      n v n b n r  máy  n t  

 ùn  l n  n o? 

  A. Bấm Ctrl+B B. Bấm v o b  u t  n  máy  n tr n t  n   ôn     

  C. Bấm Ctrl+P D. L n  F le→Pr nt    

Câu 211: C  n một  âu  ún : 

  A. C ỉ  ó n  ờ      t   mớ   ó quyền truy n ập t p   n  kèm tron  t    ã         



  B. Tron   ộp t    ến (Inbox) k ôn  t    ó t    ủ  n  ờ  k ôn  quen 

  C. K         ó t   p  n  ồ  t  k ẳn    n  n  ờ  n ận      n ận      t   

  D. Tron  t      n t   ó   n  kèm t p  n  ờ       ó t   n u      t     n  n   n về một số  ặ     m  ủ  

t p 

Câu 212:    I   11          on trỏ so n t  o về  ầu  òn     n t ờ  tron  Wor  t  n ấn p  m n o s u 

 ây?  

  A. Ctrl + End B. Home C. Page Down D. End 

Câu 213:    I    6 Tron   ộp t o   F n    Repl  e       m t   ần t m k ếm v o m  : 

  A. Find what 

Câu 5 
B. Search for C. Replace with D. Match case 

Câu 214:    I       T    p p  m     án 

  A. Ctrl + Z B. Ctrl + C C. Ctrl + X D. Ctrl + V 

Câu 215: WWW là từ viết tắt của cụm từ nào: 

  A. World Wide Web B. Wesite World Web C. Wide With World D. Wide World Web 

Câu 216: Phát biểu nào sau đây về điểm truy cập không dây (WAP) là sai: 

  A. WAP l  v ết t t  ủ  W reless A  ess Po nt 

  B. M        n n   ủ  WAP  ều      t      p tron  bộ   n  tuyến k ôn   ây 

  C. WAP k ôn    o p ép kết nố  m n  k ôn   ây v o m n   ó  ây 

  D. WAP  ùn     kết nố   á  máy t n  tron  m n  k ôn   ây 

Câu 217:    I      Côn  v    n o s u  ây k ôn  l  n qu n  ến   n    n  ký tự: 

  A.   n    n    ữ   o   n  òn  kẻ B. T  y     k  u   ữ 

  C.   n    n m u s    D. T  y     k o n   á     ữ   á   òn  

Câu 218: C ủ sở  ữu  ủ  Internet l : 

  A. Intel B. K ôn     l    ủ sở  ữu  ủ  Internet 

  C. Microsoft D. Google 

Câu 219:    I 6          èn   n  tr n   n   on trỏ   n     n tron  b n   t     n: 

  A. Layout/Insert Below B. Home/Insert Below  

  C. Layout/Insert Above  D. Home/Insert Above 

Câu 220: Các máy tính trong mạng Internet giao tiếp với nhau bằng cách nào? 

  A. Do  ùn  s    n  bộ    o t    TCP/IP 

  B. Do  ó tr n  b  n      n ôn n ữ   ữ   á  máy t n  

  C. Do  ùn    un  một lo   n ôn n ữ     l  n ôn n ữ s  u v n b n 

  D. Do s    n    un  một lo   n ôn n ữ l  t ến  An  

Câu 221:    I             n to n bộ v n b n t   ùn  t    p p  m n o   ớ   ây? 

  A. Ctrl + C B. Ctrl + X C. Ctrl + B D. Ctrl + A 

Câu 222: Web  ộn  l   á  tr n  Web: 

  A. Có n  ều tr n  l  n kết  ến tr n    ủ Home p  e 

  B. P   n  án k á  

  C. Mở r  k   n n  t  n  tá    ữ  n  ờ   ùn  v  máy   ủ 

  D. Có t    ó n  ều v  eo   n   ộn     

Câu 223:    I    6  T n t p  o Wor    1  t o r   ó p ần mở rộn  l    ? 

  A. .DOCX B. .TXT C. .EXE D. .COM 

Câu 224:    I 6 11  Tron  Wor    1        n b n   t   ặt  on trỏ v o tron  b n     n rồ  t ự     n l n  

  A. LayoutSelectCell B. LayoutSelectColumn C. LayoutSelectRow D. LayoutSelectTable 

Câu 225:    I    8       n    n    m t  “V  t N m” t  n  “V  t N m”  s u k      n   m t   ó t   ần 

 ùn  t    p p  m n o   ớ   ây? 

  A. Ctrl+I B. Ctrl+U C. Ctrl+B D. Ctrl+E 

Câu 226: Muốn t o  á  ký    u ở  ầu m    o n  t  t ự     n: 

  A. Insert --> Bullets and Numbering --> Numbered 



  B. Format -->Bullets and Numbering --> Bulleted 

  C. Home --> Paragraph Bulleted  

  D. Format -->Bullets and Numbering -->Numbered 

Câu 227: G  o t    l    ? 

  A. Bộ quy t   m  tất     á  máy t n   ều p    tuân t ủ 

  B. Bộ quy t     úp máy t n  tố   u v  t ự     n      n  ều  ôn  v      n  

  C. Quy tr n    o p ép t ự     n v    b o mật máy t n  

  D. Quy tr n    o p ép  á  máy t n  v o      m n  

Câu 228: Trong MS Word 201      l u trữ nộ   un  v n b n   n  l m v       n t   m  vẫn   ữ n uy n 

b n  ố   t     n l n  n o tron  t ẻ r bbon F le?  

  A.  Copy to  B.  Save  C.  Copy  D.  Save As  

Câu 229:    I       Ctrl + X l  t    p p  m  ó tá    n    ? 

  A. P   n  án k á  B. Dán C. Copy D. C t 

Câu 230: Một hộp thư điện tử bao gồm mấy phần? 

  A. 4 B. 3 C. 2 D. 5 

Câu 231:    I        bật t t   ế  ộ   ữ  o     ữ t  ờn   t  s    n  p  m: 

  A. Caps Lock B. Backspace C. Mũ  t n   →  D. Space 

Câu 232:    I   1  T  n        á  b  u t  n   ủ   á  l n  t  ờn   ùn tron  wor    1  l  

  A. Formating B. Standard C. Status D. Ridbon 

Câu 233:    I   1   P  m t t   ỉ số tr n l : 

  A. Ctrl + Shift + N B. Ctrl + Shift + + C. Ctrl + = D. P   n  án k á  

Câu 234:    I   17       n    n  tr n   t   ần t ự     n l n : 

  A. P  e L yout → P  e Setup B. V ew → P  e Setup… 

  C. Home → P  e Setup… D. F le → P  e Setup… 

Câu 235:    I    7       n lề  ều     b n   o  o n v n b n  s u k        on trỏ  ến  o n v n  ần   n  

  n   t  t ự     n 

  A. Insert \ Justify B. File \ Page setup  

  C. N ấn t    p p  m Ctrl + E D. N ấn t    p p  m Ctrl + J  

Câu 236:    I   1           on trỏ so n t  o về  uố  v n b n t  s    n : 

  A. Home B. End C. Ctrl + End D. Page Down 

Câu 237:    I    6  P  m t t   n    n   n  ậm: 

  A. Ctrl + U B. Ctrl + G C. Ctrl + N D. Ctrl + B 

Câu 238:    I       Tron  so n t  o v n b n  một số t uộ  t n    n    n  ký tự    b n  ồm  ó: 

  A. C  A  B  C B. P ôn    ữ  C. K  u   ữ  D. Cỡ   ữ v  m u s    

Câu 239:    I       P  m t t  n v n b n l : 

  A. Ctrl + Z B. Ctrl + N C. Ctrl + I D. Ctrl + P 

Câu 240:    I    7 Tron   ộp t o   F n    Repl  e       m t  sẽ t  y t ế v o m  :  

  A. Replace with B. Search for C. Match case D. Whole words only 

Câu 241: C  n p át b  u  ún  

  A. C ỉ  ó t       m  l   o 1 n  ờ   ùn  lú  

  B. C ỉ  ó t       m  l   o n  u tron   ùn  1 t       

  C. T p   n  kèm tron  m  l   ỉ  ó t   l    n   n   oặ  âm t  n  

  D. Tron  m  l  s u @    n  l        ỉ máy   ủ  ủ   ộp t   

Câu 242:    I 6 1   Muốn t  y     k    t  ớ     ều   o  ủ  ô   ột    n  tron  b n  t   t  s    n : 

  A. Layout  Cell Size  Height B. G ữ Ctrl v  kéo  on l n   uột về p    s u 

  C. G ữ Ctrl v  kéo  on l n   uột về p    tr ớ  D. Layout  Cell Size  Width 

Câu 243: K   kết nố  t  n  m n  máy t n   t   ó t  : 

  A. Cùn  s    n    un  1 máy  n B. S o   ép  ữ l  u  á  máy vớ  n  u 

  C. Tất     á  p   n  án tr n  D. Cùn  s    n    un   ữ l  u 



Câu 244:    I 6  6  Tron  Wor    1     xó  b n  s u k    ặt  on trỏ v o b n  t   ùn  l n  n o s u: 

  A. Layout -> Delete -> Table B. Table -> Insert -> Table  

  C. Table -> Select -> Table D. Table -> Delete -> Table 

Câu 245:    I 6     Tron  Wor    1     t o b n   t  t ự     n: 

  A. Insert → T ble B. Tools → Insert → T ble 

  C. Insert → Insert → T ble D. Insert → T ble → Insert T ble  

Câu 246:    I          xó  p ần v n b n         n  t  t ự     n: 

  A. C  n l n  E  t → X B. C  n l n  E  t→ P ste 

  C. N ấn t    p p  m Ctrl+X D. C  n l n  E  t→ Copy 

 
 

 

 

 

 


